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The 

Summit 

I 
t’s a busy time for WAURISA. We 

have many volunteers actively work-

ing on final details for our 17th annual 

conference, May 13-14 in Tacoma. I encour-

age you to spend some time reading this 

issue to learn about the new activities we 

have planned and get the inside scoop on 

some of the excellent sessions the confer-

ence has to offer. We’re well on track for 

300 conference attendees this year, and a 

record number of you are also planning to 

participate in pre-conference workshops on 

Monday, May 12.  

As you plan for your time at the confer-

ence, I have a suggestion: think about ideas 

to share while you are with your colleagues 

in Tacoma. We’re making it pretty easy to 

do this with a new thread we’ve woven 

into the conference this year called 
(Continued on page 20) 
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T 
umwater is the oldest American settlement in the 

State of Washington. Only Fort Nisqually, run by 

the British Hudson’s Bay Company, predates the 

Tumwater settlement. The City of Tumwater’s motto is 

“Washington’s First Community”. It was founded in 1845 as 

the “City of New Market” but by 1863 it became known as 

“Tumwater,” partly based on the Chinook jargon for 

“waterfall” which is “tumtum”. Tumwater was officially in-

corporated as a town in 1869 and became a city in 1962. To-

day, Tumwater is a vibrant and growing city of 18,000 resi-

dents and is famous for the series of waterfalls on the 

Deschutes River and the now- closed Olympia Brewery.   

The history of modern mapping in Tumwater and for most of 

us in the Puget Sound region began in 1792 when Captain 

George Vancouver’s British survey party mapped Puget 

Sound, including Budd Inlet at the north end of Tumwater. In 

the years following this initial survey, many paper or other 

“hard copy” maps, surveys, plats, etc. were made of the Tum-

water area. Here at the City of Tumwater, we have hard copy 

maps that date back to the late 1800s. The story of “paper 

The Story of Digital Mapping & GIS at the City of Tumwater 
By: Matt Stull, GISP 

maps” is a familiar one to many of us who work in public 

agencies, especially the older ones. Although quite interest-

ing, this article won’t cover the history of hard copy maps, 

but rather it will explore the more recent history of digital 

mapping and GIS at the City. 

 

Non-GIS Digital Mapping 
At some time prior to 1990, the City purchased AutoCAD 

and used it to create and maintain a large scale street map; 

this was first digital map of Tumwater. In 1994, the City hired 

a new City Surveyor. His duties included overseeing and 

enhancing the City’s digital mapping program. By 1995 he 

had grown the City’s digital mapping program to include 

sewer and water utilities and parcels. Around this same time, 

the City started using a computerized maintenance manage-

ment system that worked in conjunction with the AutoCAD 

maps. This maintenance management system did not include 

an internal GIS component. Later, other areas were added to 

(Continued on page 4) 



 

 

“adopted” topographic map and provided the USGS with 

the updates (Figure 1). As valuable as the updates were, the 

technology was not yet available to take full advantage of 

the work done by the volunteers. In addition, some quadran-

gles were so out-of-date, the amount of update work re-

quired could be quite daunting to the volunteer who was 

asked to complete edits within 12 months. 

Realizing the limitations of the first VGI effort and taking 

advantage of new technology, the program was revamped 

and renamed The National Map Corps in 2001. Emphasis 

shifted from manually annotating every feature on the pub-

lished map to collecting man-made structures using 

handheld GPS units which had recently become affordable 

for many individuals. Between 2003 and 2006, over 1,000 

citizen mappers collected over 22,800 data points which 

were submitted in a variety of formats – both analog and 

digital. As time passed and technology changed, VGI at the 

Volunteered Geographic Information Drives USGS National Map Corps  
By: Elizabeth McCartney 

U 
sing crowd-sourcing techniques, the US Geologi-

cal Survey (USGS) Volunteered Geographic Infor-

mation (VGI) project known as The National Map 

Corps (TNMCorps) encourages citizen volunteers to collect 

and edit data about manmade structures in an effort to pro-

vide accurate and authoritative spatial map data for the 

USGS National Geospatial Program’s (NGP) web-based The 

National Map. In an era where dwindling budgets struggle to 

coexist with mandates for transparency and citizen involve-

ment, crowd-sourcing is a viable solution for many agencies. 

VGI is not new to the USGS, but past efforts have been ham-

pered by available technologies. Over the past two decades, 

the USGS has sponsored various forms of volunteer map data 

collection projects. In 1994, the Earth Science Corps was es-

tablished, and over the next seven years 3,300 volunteers an-

notated between 100 and 300 paper topographic maps each 

year. Citizen mappers reviewed every feature of their 
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Figure 1.  Example of handwritten volunteer submissions through Adopt-A-Quad. 
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USGS also evolved.  In 2006, a web-based collection tool was 

launched in order to help standardize the submission process 

(Figure 2), but the transition from the database onto the USGS 

topographic maps remained problematic and continued to 

require a fair amount of USGS resources to process. In 2008, 

the program was suspended due to lack of resources. 

Today, the perfect storm of improved technology, social me-

dia, and ever decreasing resources has once again made 

crowd-sourcing an attractive option. After several pilot pro-

jects to determine the viability of bringing back the volunteer 

mapping program, The National Map Corps volunteers are 

successfully editing 10 different structure types in all 50 states 

including schools, hospitals, post offices, police stations and 

other important public buildings. Using National Agricultur-

al Imagery Program (NAIP) imagery as the primary base 

layer, volunteers collect and improve structures data by add-

ing new features, removing obsolete points, and correcting 

existing data. Edits are contributed through a web-based 

mapping platform built using open source technology devel-

oped by OpenStreetMap (Figure 3). Points edited are incorpo-

rated into The National Map and ultimately become part of 

USTopo. 

Data quality is a common concern regarding VGI. In order to 

address those concerns, an analysis of the FY12 Colorado 

pilot of the VGI project was conducted. For all structure fea-

ture types, volunteer involvement was found to improve po-

sitional and attribute accuracy, and reduce errors of commis-

sion. Errors of omission are more difficult to study and quan-

tify, but a study of post offices provides evidence that the 

volunteer model improves completeness as well. The corner-

stone of this model is a Wikipedia-like hierarchy of editors 

and reviewers. The Colorado pilot demonstrated that volun-

teer edits improve our baseline structures data; that further 

peer review by advanced volunteers improves the data fur-

ther; and that sample-based inspection by USGS personnel 

can monitor these processes. The study indicates that the 

model and procedures will scale to national scope. A second, 

nationwide, data quality study is in progress. 

Successful crowd-sourcing is not without challenges, some of 

which include volunteer recruitment, volunteer engagement, 

(Continued on page 19) 

Figure 2:  Example of early web-based collection. 

Figure 3: Web-based editing platform based on OpenStreetMap infrastructure.  

http://navigator.er.usgs.gov/
http://navigator.er.usgs.gov/
https://www.fsa.usda.gov/FSA/apfoapp?area=home&subject=prog&topic=nai
https://www.fsa.usda.gov/FSA/apfoapp?area=home&subject=prog&topic=nai
http://www.openstreetmap.org/
http://nationalmap.gov/ustopo/


 

 

the AutoCAD mapping program like stormwater in 2000 and 

street assets in 2008. In 2007, the City migrated from the origi-

nal maintenance management system to a new system. This 

new system included a GIS mapping application based on 

ESRI’s Map Objects. This is the system that the City uses to-

day. There will be more discussion about this system later in 

the article. For several years starting around 2000, the Auto-

CAD digital mapping program existed alongside another 

City GIS system that the Planning and Permitting depart-

ments used. The history of this other GIS system will be dis-

cussed in the next section.  

 

GIS Mapping 
The history of GIS for the City began in 1984 when Thurston 

County, along with the Cities of Olympia, Lacey, and Tum-

(Continued from page 1) water, as well as the Thurston Regional Planning Council, 

began an effort to develop a regional GIS mapping system. 

Tumwater was part of the initial feasibility study to assess the 

needs and requirements for the regional GIS system. As a 

result of that study, the County, along with the Cities of 

Olympia and Lacey, and the Thurston Regional Planning 

Council, formed what was called the “Thurston Geographic 

Information Facility” in 1985/86. Later, this group was re-

named to the “Thurston Geodata Center”, as we know it to-

day. While Tumwater was not directly involved in this effort, 

this group was and still is instrumental in helping to augment 

and enhance the City’s GIS system. 

The City began utilizing GIS in the late 1990s when it con-

tracted with the Thurston Regional Planning Council for GIS 

services. After seeing the benefits of GIS, the City decided to 
(Continued on page 12) 
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Figure 1. A page of the City of Tumwater’s Street Map Book 
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G 
IS data collection and maintenance are expensive 

activities. Various methods and devices have been 

used in the past to collect GIS data, and new meth-

ods and technologies emerge every year. By using newer 

software and hardware one can reduce the cost of data collec-

tion, save employees time, and more quickly share data as it 

gets collected in the field. Although there are many options 

available from various vendors, including Esri’s ArcPad and 

Collector for ArcGIS, this article focuses on Esri’s ArcGIS for 

Windows Mobile solution.  

ArcGIS for Windows Mobile runs on the Windows platform 

and works on tablet PCs and desktops. It works both with 

and without a touch screen. The software also comes with an 

SDK (software development kit) that can be used for custom-

izing your mobile project. 

ArcGIS for Mobile software installs two components: the Mo-

bile Project Center (MPC) and ArcGIS Mobile. Mobile Project 

Center is used to design the mobile project, whereas ArcGIS 

Mobile is used to collect GIS data in the field.  

Planning is critical for any successful project. Apart from 

planning it is important to follow a workflow that helps in 

building datasets for efficient data collection, authoring a 

map, publishing an ArcGIS for Server mobile service, design-

ing and customizing a project, and finally deploying a mobile 

project. It is also important to determine if field staff can or 

should have network connectivity, and to weigh the pros and 

cons of working in a connected versus disconnected environ-

ment.   

Here the main steps necessary to build an ArcGIS for Win-

dows Mobile project: 

 

I. Build a mobile geodatabase 
Create a geodatabase with one or more feature classes for 

data collection. The geodatabase can either be a file-based or 

an SDE (Spatial Database Engine) geodatabase. An SDE geo-

database is preferred because it can be used to synchronize 

field data edits back to the master SDE feature classes. Sub-

types and domains should be used for easy data entry, and to 

improve data quality. Best practices should be followed, such 

as creating alias names for feature classes and column names. 

A global ID is required for each editable layer. 

 

II. Author a mobile map 
Create an ArcMap document with the data layers that will be 

edited in the field. Use Esri’s optimized symbology, keep the 

map simple, and avoid advanced behaviors such as joins and 

SQL expressions. Limit the map extent to where the data col-

lection will be performed.  

 

III. Publish a mobile service 
Publish a mobile service from the ArcMap document. (See 

Esri’s help article “Publishing a map service”.) Make sure 

that Mobile Data Access is checked on the Capabilities tab in 

the Service Editor as shown in Figure 1 (ArcGIS for Server 

10.1). Also, it is important to register the data sources. (See 

Esri’s help article “About registering your data with the serv-

er”).  

 

IV. Design and customize a mobile project 
After the mobile service is published you can design and con-

figure your mobile project in MPC by adding basemaps and 

operational layers. Basemap layers are used for background 
(Continued on page 10) 

Data Collection Using ArcGIS for Windows Mobile 
By: Harkeerat Kang, GISP 

http://resources.arcgis.com/en/help/main/10.2/index.html#//00sq00000089000000
http://resources.arcgis.com/en/help/main/10.2/index.html#//015400000505000000
http://resources.arcgis.com/en/help/main/10.2/index.html#//015400000505000000


 

 

T 
he 2014 Washington GIS Conference will take 

place at the Greater Tacoma Convention and Trade 

Center on May 12-14, building on the high standard 

of workshops, presentations and networking opportunities 

that our community has come to expect from the event. This 

year we are pleased to be incorporating some enhancements, 

centered on our theme of Communicating Our World, which 

we hope will serve to increase the professional development 

value of the event. These enhancements include: 

 Strengthening the connection between the conference 

theme and content; 

 Increasing the role of the keynote presenter, Breece Rob-

ertson; 

 Enlisting the support of a group of 

“thought leaders”; 

 Adding a new closing plenary 

session; 

 Encouraging theme-based lunch 

table discussions. 

 

A Two-Day Conversation on Communicating 

Our World 
A primary goal for this year’s conference is to encourage all 

attendees to participate in a two-day conversation on the con-

ference theme Communicating Our World. In particular, we are 

emphasizing the following three aspects of this theme: 

How have you communicated the value of GIS to your organ-

ization or clients? 

How has your use of GIS supported a communication effort? 

How have you improved communication between partici-

pants in your GIS projects? 

Through the Call for Presentations, speakers were asked to 

discuss one or more of these aspects, thus contributing to the 

larger conversation. 

 

Opening and Closing Plenary Sessions 
The opening plenary session will consist of the keynote 

presentation by Breece Robertson and the introduction of a 

group of “thought leaders” drawn from the local GIS com-

munity. Their mission will be to gather contributions to the 

conference theme from sessions and discussions with 

attendees. In the afternoon of the second day, these thought 

leaders will join Breece in the closing plenary session for a 

panel discussion to review the lessons learned from the con-

ference. Our goal is to engage as many audience members as 

possible during this panel discussion and provide a strong 

professional development experience as a way of bringing 

the conference to a close.  

 

Lunch Theme Tables 
On the first day of the conference, approximately two-thirds 

of the lunch tables will be reserved for “theme” discussions. 

This will provide an opportunity for you to 

meet others who share your interests and 

chat informally about the table theme 

with assistance from a table leader. 

Themes will include, for example, geo-

processing with Python, ArcGIS Online 

and mobile technology and open source 

web mapping. 

 

Your Role in Our Conference 
As you can probably tell, a significant number of your friends 

and colleagues in the Washington GIS community have been 

working tirelessly to put our conference together. Now, we’re 

counting on you to engage as fully as possible during the 

event and do all you can to contribute to the success of the 

conference. 

No matter where we are in our GIS careers, we always have 

experiences and ideas that are worth sharing with others. The 

more we can communicate these experiences and ideas to our 

community, the better we all will be as GIS professionals. 

Please join us at the conference and plan on staying through 

the end of the closing plenary on day two. We and your fel-

low Washington State GIS professionals are counting on you 

to help make the event another great success. 

Submitted by the Conference Planning Committee: Chuck Buzzard, 

Heather Glock, Ian Von Essen, Don Burdick, Sarah Myers, David 

Howes, Amanda Taub, Ann Stark, Cort Daniel, Joshua Greenberg, 

Lisa Stapleton, Brandy Riche, Suzanne Shull, Trisha James, Steve 

Savage, and Renee Quenneville. 

2014 Washington GIS Conference: Communicating Our World 
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No matter where we are in our 

GIS careers, we always have 

experiences and ideas that are 

worth sharing with others. 
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W 
AURISA’s annual GIS Conference will be 

taking place this year May 12-14 in Tacoma. 

The theme is “Communicating Our World”, 

and in addition to the traditional workshops, social events, 

student and professional competitions, Esri Learning Labs, 

and GIS Person of the Year award, attendees can look for-

ward to some new changes this year. 

There will be both opening and closing plenary sessions 

which will allow participants to share their thoughts, and 

themed lunch tables for networking opportunities over a 

meal.  

The keynote speaker will be Breece Robertson, the National 

GIS Director for the Trust for Public Lands. 

Much of the conference will consist of presentations by the 

GIS community. The Summit interviewed two presenter teams 

to find out what they’re planning to discuss. 

2014 Washington GIS Conference: Preview 
By: Effie Moody 

 

HPMS Network and ARNOLD – Presented by 

Allen Blake and Pat Whittaker 
Thomas Allen Blake (“Allen”) and Pat Whittaker, both of 

Washington State Department of Transportation (WSDOT) 

will speak about the GIS process they went through to create 

the first statewide transportation Linear Referencing System 

(LRS) for Washington known as “WAPR”. 

The origins of the project arose from the need to meet the 

federal requirement to report current road information which 

WSDOT gathers annually by asking local agencies for updat-

ed data. Adding a local agency road network to the WSDOT 

GIS completes the public roads requirement and shows local 

agencies where their data is on the spatial network. The local 

agencies not only see the data they are updating, but also 

how it relates to other data on the network. 

The local agency-owned road datasets represent Arterial and Collector roads as routes (All_Counties_CreateRoutes), all county-owned roads as 

routes (All_Counties_CreateRoutes_CRAB), and the working local agency roads polyline that is used to create the routes.  

Washington’s total public roads consist of 7,000 miles of state highways, 40,000 miles of county roads, 18,000 miles of city streets, 10,000 miles owned 

by other state agencies (State Parks, Natural Resources, etc.) and  9,000 miles of federal roads (Forest Service, etc.) 
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WSDOT has been collaborating with local agencies to use 

their LRS to create their local agency road network which 

meets the Federal Highway Administration’s ‘ARNOLD’ 

requirement. (ARNOLD is the Federal Highway Administra-

tion’s internal name for the ‘All Roads Network Of Linear 

referenced Data’). 

The future is driven by both the demand, requirements of the 

Highway Performance Monitoring System (HPMS), and 

planning.  The HPMS requirements have grown from a feder-

al push for the states to ensure their federal highway funds 

are being used effectively by measuring performance. Placing 

road-related data on a single spatial network for sharing and 

analysis also ensures that WSDOT is collecting and analyzing 

data as efficiently as possible. 

Possibly the most challenging thing Allen and Pat have found 

in this process has been the integration of using multiple local 

agency road geometries and LRS’s into a single authoritative 

system. 

What Allen and Pat have found most rewarding is to finally 

represent all local agency data in a single network and use 

this as a tool to collect, analyze and report data. 

 

Which Way to Go? – It’s “A GO” or ArcGIS 

Online – Presented by Brian Devereaux 
As the Puyallup School District’s Planning Director, Brian 

Devereaux is enthusiastically spreading his passion for GIS 

out to his organization and community. Given the need to 

communicate plans and information to the district employ-

ees, agencies and a community of 120,000 residents, he fig-

ured what better way than to use ArcGIS Online? ArcGIS 

Online made sense as a cost-efficient tool that informs, yet 

effectively and creatively reaches out to his target audience. 

Does ESRI’s ArcGIS Online (“A GO”) increase one’s 

ability to communicate important information?  In his 

current employment, Brian’s focus happens to be on planning 

and he needed a tool that was interesting and could reach a 

lot of people.  As GIS professionals know, there are many 

tools to convey information to our target audiences, but GIS 

makes it fun for the users with interactive maps while meet-

ing the goals of getting the information out.  Brian found that 

A GO is the tool of choice when it comes to engaging the au-

dience with a richer experience which makes them want 

more, compared to a static PDF information map or docu-

ment as was used prior in his district.  

As in many school districts, Puyallup did not have its own 

GIS department, nor were there staff with GIS professional 

experience to assist in the development of a GIS system. Be-
(Continued on page 14) 

Presenters Thomas (“Allen”) Blake  (left) and Pat Whittaker (right) 



 

 

Page 10 Issue 34 

Figure 1. The “Capabilities” section of the Service Editor. 

data and for reference. Operational layers are used for query-

ing, identifying, and editing data in the field. Here are the 

steps to create a mobile project: 

1. Open MPC. Click File > New to open a blank project. 

2. Add basemap layers to your project by clicking the Add 

button (Figure 2). You have the option of using ArcGIS 

Online basemaps, ArcGIS Server tiled map services, or 

basemaps from a basemap catalog which references fold-

er locations that contain cached map tiles. The first two 

options require network connectivity in the field. A 

cached basemap folder should be used if the mobile ap-

plication will be used in a disconnected environment. 

3. Add operational data layers (for field data collection) by 

clicking the Add button again. Then, for use in a discon-

nected environment pick the option “Operational Layer 

from Mobile Service.” For use in a connected environ-

ment, you can pick either: “Operational Layer from Fea-

ture Service” or “Operational Layer from Mobile Ser-

vice”. 

4. Configure operational layers and their attributes by click-

ing the Layer and Fields tabs. (See Configuring Map Lay-

er Properties and Configuring Map Layer Fields).  

5. Define a project extent by clicking Project > Project ex-

tent. This extent is used for identifying and editing data 

in ArcGIS Mobile. 

6. Configure tasks and capabilities or use default proper-

ties.  

7. Validate your project by clicking Project > Validate to 

check if there are any errors. 

8. Save your project. The first time you will be prompted to 

(Continued from page 5) 

set some project properties, such as a project description, 

a thumbnail image, etc. You can also edit properties at a 

later time by clicking Project > Properties.  

V. Deploy a mobile project 
The mobile project can be deployed by copying the project 

folder created in Step 8 and making it available for the field 

staffers to load onto their field devices. This project should be 

updated on the devices only if there is a schema change in 

one of the feature classes that staff edits in the field, if you 

add or remove a basemap, or if an operational layer or project 

extent changes. This effort should be coordinated with your 

field staff. See also Esri’s help article about deploying mobile 

projects. 

 

ArcGIS Mobile 
When deploying a project to multiple devices, it is important 

to use the same folder structure for all devices. There are a 

few application settings in ArcGIS Mobile that should be con-

figured on each device for each user. Click ArcGIS Mobile 

button > View and Manage Settings > Application Settings 

and then add Project and Basemap Folders. This helps to 

Data Collection Using ArcGIS for Windows Mobile 

http://resources.arcgis.com/en/help/windows-mobile/10.2/index.html#/Configuring_map_layer_properties/007v0000000s000000/
http://resources.arcgis.com/en/help/windows-mobile/10.2/index.html#/Configuring_map_layer_properties/007v0000000s000000/
http://resources.arcgis.com/en/help/windows-mobile/10.2/index.html#/Configuring_map_layer_fields/007v0000000t000000/
http://resources.arcgis.com/en/help/windows-mobile/10.2/index.html#/Configuring_tasks_and_capabilities/007v00000051000000/
http://resources.arcgis.com/en/help/windows-mobile/10.2/index.html#/Deploying_a_mobile_project/007v0000004v000000/
http://resources.arcgis.com/en/help/windows-mobile/10.2/index.html#/Deploying_a_mobile_project/007v0000004v000000/
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Figure 2. How to add basemap layers to your mobile project. 

keep your basemap (if using caches) and mobile projects in 

organized folders. Figure 4 illustrates the folder structure and 

how the folders are added in ArcGIS Mobile. 

There are other ArcGIS Mobile settings such as Map Settings, 

GPS Settings, etc. that can be set up as well by clicking 

ArcGIS Mobile button > View and Manage Settings. 

The ArcGIS for Windows Mobile solution works really well. 

Following a few best practices will save time in the long run. 

If collecting live data, it would be a good practice to secure 

your mobile or feature services. Use of aliases for feature clas-

ses and column names saves time when designing your pro-

ject in MPC. The use of domain and sub types will save the 

task of typing in the field when juggling lots of equipment.  

 

Editor’s Note:  Please look forward to a second installment of “Data 

Collection Using ArcGIS for Windows Mobile” in a future issue, 

which will focus on how to collect data in the field. 

Figure 3. Configuring project properties. 

Figure 4. Folder structure, and how to add folders. 
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The Story of Digital Mapping & GIS at the City of Tumwater 

purchase its own GIS software and bring the GIS work in-

house. In 2000, the planning and permitting departments 

purchased a copy of Esri’s ArcView 3. The two departments 

shared this copy of ArcView on a single computer. At the 

same time, the planning manager and the permit manager 

were both sent to GIS training on the new software while 

another planner learned GIS from an instructional book.    

As you can imagine, there was a lot of work to do to get the 

GIS system off the ground. One of the City planners took 

over responsibility for the zoning maps from the City Survey-

or in the early 2000s. The zoning maps were not yet in GIS 

format, so he had to manually create all the zoning polygons 

for the City as well as the urban growth area. This same plan-

ner completed another large data creation project where he 

mapped every single annexation for the last 150 years! It’s 

worth noting that the planner who did these two projects was 

the one who learned on his own from the instructional book. 

In the years since GIS started, this same planner has handled 

many of the GIS mapping requests. He said that up until re-

cently, he used to get about one map request a day on aver-

age from every city department. 

In 2006, the City set up a GPS base station. This base station 

resides on the roof of the Public Works road shop building, 

where it has a relatively unobstructed view of the sky. It uses 

a Trimble NetR5 GNSS receiver. The base station has been 

part of the Washington State Reference Net-

work (WSRN) of GPS base stations since 

it was brought online. The city has con-

tinued to be a partner in the WSRN 

since the base station was established. 

After the City Surveyor retired in 2012, 

the City decided to change the City Sur-

veyor position to be a GIS Coordinator posi-

tion. This is the first “real” GIS position that the City has ever 

had. Up until this last November, the City relied on the City 

Surveyor, a handful of Public Works staff and the previously 

mentioned planning staff members to handle GIS tasks. That 

wraps up the history of the system and brings us up to where 

we are today. 

 

Current GIS System 
In November of 2013, I was hired to fill the new GIS Coordi-

nator position. One of my first tasks was to do an assessment 

(Continued from page 4) 

of the current status of the City’s GIS system. Thankfully, the 

retired City Surveyor left a 41-page document that described 

the GIS and mapping responsibilities, programs and process-

es of his position. This document was crucial in helping me 

develop the assessment. In addition to reviewing this docu-

ment, I interviewed City staff members who had been in-

volved with the GIS. I also reviewed the current GIS data, 

software and hardware. I completed the 

assessment in December and submitted 

it to management. 

Part of the GIS system assessment was 

to evaluate the City’s GPS equipment. 

Most of the GPS equipment is for high 

precision survey-grade work. Many of 

these devices are old and are going to surplus 

but we’ll keep a few of them for our survey technician to use. 

One of the GPS units we had was a 2005 series Trimble Ge-

oXH, which was a great mapping grade GPS unit years ago, 

but it’s no longer supported, and the City needed an upgrad-

ed device. To meet this need, the City purchased a new Trim-

ble GeoXH 6000 series GPS unit. This new unit has been very 

useful for mapping and photographing our utilities! 

Another part of the assessment showed a need to upgrade 

(Continued on page 17) 

The retired City Surveyor left a 

41-page document that 

described the GIS and his related 

responsibilities. 
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U 
RISA has published the first in what is intended 

to be a series of occasional GIS Management Insti-

tute® discussion papers. These papers are intend-

ed to stimulate thought and open discussion about issues 

related to GIS management that are important to the GIS 

community. The paper, titled “A Distribut-

ed Model for Effective National Geo-

spatial Data Management: Building a 

National Data Sharing Infrastructure” 

is available online. Jim Sparks (State of 

Indiana GIO), Philip Worrall (Indiana 

Geographic Information Council Execu-

tive Director), and Kevin Mickey (Indiana 

University Polis Center Geospatial Education Director) are 

authors of the paper. 

Upon the discussion paper’s publication, Greg Babinski, 

GISP, Past President of URISA, noted: 

“Recent studies have demonstrated the tremendous 

return on investment (ROI) from deploying geospa-

tial technology. Of course geospatial technology 

Discussion Paper from URISA GIS Management Institute 
By: Wendy Nelson 

relies on the availability of high quality, current spa-

tial data to deliver these benefits. But within the 

United States, we have been behind many other 

countries in completing development of a single 

authoritative spatial database. 

Many other countries that I have 

visited, including the UK, UAE, 

China, Taiwan, and the EU coun-

tries, all have a top-down central 

government funded approach to 

developing GIS data for use at the 

national, regional, and local levels. In 

the US, we have not taken this approach. We have a 

fractured infrastructure, with local government 

agencies generally (but not universally) having good 

data, but little motivation to comply with standards 

or policies that would facilitate compilation into a 

comprehensive national database. Local government 

agencies and many states lack funding to support a 

comprehensive approach to building a national data 

sharing infrastructure. 

In the discussion paper, Jim Sparks, Philip Worrall, 

and Kevin Mickey have laid out these issues and 

made a variety of proposals based on best practices 

that have worked on smaller scales, rational national 

coordination, and a proposal for effective funding. 

I encourage GIS professionals to read this important 

paper and provide your comments and further sug-

gestions to the authors. Also consider attend upcom-

ing events where this paper will be the subject of a 

panel discussion, including the Washington GIS 

Conference (May 12-14 in Tacoma) and GIS-Pro 

2014: URISA’s Annual Conference (September 8-11 

in New Orleans).” 

Interested authors should send their papers to URISA’s Exec-

utive Director (wnelson@urisa.org) for review and considera-

tion by the GIS Management Institute®. For more infor-

mation about the GIS Management Institute® including the 

GIS Capability Maturity Model, visit http://www.urisa.org/

main/gis-management-institute/. 

We have been behind many other 

countries in completing 

development of a single 

authoritative spatial database. 

http://www.urisa.org/main/gis-management-institute/
http://www.waurisa.org/conferences/2014_Conference_Index.php
http://www.waurisa.org/conferences/2014_Conference_Index.php
http://www.urisa.org/education-events/gis-pro-annual-conference/
http://www.urisa.org/education-events/gis-pro-annual-conference/
mailto:wnelson@urisa.org
http://www.urisa.org/main/gis-management-institute/
http://www.urisa.org/main/gis-management-institute/
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WAURISA GIS Conference Preview 

ing the sole user of ArcGIS for Desktop in his organization at 

the time, Brian found it challenging to communicate the po-

tential for its application within the organization.  Budgets 

don’t allow everyone to have desktop GIS and that is why 

Brian found that A GO is a game changer in every way.  

A GO has the ability to share Brian’s regular 

important information in a way which 

can compete with other entertainment 

and exciting technology in today’s 

world. Residential growth in the 

school district as an example, seem-

ingly mundane information to some, 

now grabs at everyone’s attention and 

keeps the target audience involved. In the Puyallup School 

District, student population growth doubled over the past 25 

years with 205 portable classrooms at 32 sites – the highest in 

the state. A GO could demonstrate the potential impacts and 

analysis, and what it really means for future planning needs.  

Brian’s Planning Department at the Puyallup School District 

transitioned to maintaining new development data to visual-

ize where growth was occurring when combined with school 

(Continued from page 9) 

attendance. Recently, the department created point type fea-

tures for school impact fee payments and residential develop-

ment for buildings or new housing to visualize where to ex-

pect new students within a 4-6 month time frame. With A 

GO, the ability to share this new student impact visually was 

invaluable both inside and outside the department.  This one 

web map of new students led to direct contact with local col-

leges, newspaper articles, Chamber of Commerce, other staff 

members from local agencies, and community residents. And 

this is just one example! 

Now when school capital funding comes 

up for a vote, the maps are a powerful 

communication tool for voters to see 

planned solutions which address the 

needs of the community.  The map as 

shown on A GO is available to all and 

provides the ability to each resident to see 

what residential projects are forthcoming or 

under construction within their own region of the district. 

This specific type of information about the school district and 

community isn’t readily accessible anywhere else, and has 

generated much interest from various groups. The District’s 

A GO site is http://psd3.maps.arcgis.com/home/index.html 

They say a picture is worth a thousand words, but 

maps and A GO connect us all geographically.  Come 

hear Brian speak at the WAURISA conference and hear more 

examples of how A GO has changed the community in which 

he works and lives. You too may visualize its potential to be 

used in your work and community! 

 

In Brian’s own words 

(The Summit): What is the future of this use? Will you in-

crease; expand services using GIS or ArcGIS Online? 

(Brian): The district’s AGO website has created an aware-

ness of GIS and its potential application in various depart-

ments within our district. Several of our educational program 

directors that oversee programs such as our Highly-Capable 

and Special Education programs, for example, are now aware 

that geocoding the physical addresses of students within 

their program will help them make more informed decisions 

about which school locations should house these regional 

programs. So from that standpoint, I’m already witnessing 

the use of GIS spreading outside of our department.  I see 

AGO will continue to be used as a tool to share such infor-

mation to the target audience(s) of choice. 

(Continued on page 20) 

Now when school capital funding 

comes up for a vote, the maps are 

a powerful communication tool 

for voters. 

http://psd3.maps.arcgis.com/home/index.html
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Emergency & Disaster Preparedness Workshop 

O 
ne of the roles of the WAURISA Professional 

Development Committee is to provide education-

al opportunities for our members. For a number of 

years we have been successfully holding workshops both in 

conjunction with our annual conference and day long events 

throughout the year. In response to several requests on the 

2013 WA GIS Conference survey we decided to organize a 

workshop focusing on disaster events.  WAURISA partnered 

with FEMA to design a workshop called “Emergency and 

Disaster Preparedness for the GIS Professional”.  The goal 

was to inform GIS practitioners on how to effectively support 

public safety responders on events of state, regional, and lo-

cal significance. 

The first half of the February 4, 2014 workshop focused on 

FEMA activities including their HAZUS model, while the 

afternoon speakers focused more on local data sources and 

incident types. 

There was a fantastic turnout for the workshop which was 

held at the Sand Point NOAA facility in Magnuson Park on 

the shores of Lake Washington in Seattle.  Attendance was 

around 120 people including speakers, and was composed of 

government, academic, and private sector participants. Peo-

ple traveled from as far away as Portland, Oregon, and one 

gentleman e-mailed to ask if we might do something like this 

in Texas. For an in-depth review, please read Holly Glaser’s 

story on Page 16. 

With tight budgets and cutbacks in government spending, 

one of the goals of this workshop was to provide a very low-

cost training opportunity.  We were able to keep the registra-

tion price low through several cost-saving measures. FEMA 

was able to provide the use of the auditorium at no cost and 

since there was a cafeteria on site, attendees had the option of 

bringing their own lunch or purchasing a meal. We also were 

able to provide a morning coffee and snack break through a 

generous sponsorship provided by three participating ven-

dors (Salish Coast Sciences, 3Di, and Puget Sound GIS). 

WAURISA  intends to continue providing professional devel-

opment in the form of workshops and training. These oppor-

tunities are successful not only because of the great support 

we get from our regional attendees, but also because of the 

wealth of subject expertise and experience we collectively 

have in Washington. Becoming involved in future WAURISA 

activities like this is as easy as reaching out to me or any of 

our board members, or emailing workshops@waurisa.org 

From the Organizer 
By: Joshua Greenberg, GISP, WAURISA Professional Development Committee Chair 

A view from the tour of the NOAA National Weather Service Forecast Center. Photo by A. Paul Newman. 

mailto:workshops@waurisa.org


 

 

From an Attendee 

By: Holly Glaser, GISP 

A 
t WAURISA’s Emergency and Disaster Prepared-

ness Workshop, GIS professionals, emergency 

management professionals, and first responders 

came together to learn about various GIS tools and resources 

available to help with hazard mitigation, disaster response 

and 9-1-1 dispatch. 

Peter Tassoni, the State Hazard Mitigation Officer, kicked off 

the event with a presentation titled “Use of GIS and HAZUS 

at the WA Emergency Management Division’s Emergency 

Operations Center and in the WA Enhanced State Hazard 

Mitigation Plan.” HAZUS is FEMA’s hazard modeling soft-

ware, which utilizes GIS data as input. Tassoni discussed 

how GIS data and HAZUS software could be used to model 

hazard mitigations for repeatedly damaged areas and find 

solutions that were a good return on investment. For in-

stance, Centralia flooded twice in ten years and repeatedly 

rebuilt 78 buildings. By combining economic models with 

HAZUS, different mitigation approaches could be compared. 

For Centralia, the best solution was to elevate the homes. This 

prevented flood damage and saved hundreds of millions of 

dollars in repairs - and had the additional benefit of making 

the community safer and more viable. 

Kelly Stone, a risk analyst for FEMA, talked about using 
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Emergency & Disaster Preparedness Workshop 

HAZUS and GIS data to assess and prepare for the economic 

impact after the initial phases of a disaster.  

In Washington State, we are subject to volcanic, seismic, fire 

and tsunami hazards, among others. Dr. Recep (Ray) Cakir 

described the Department of Natural Resources’ Washington 

State Geologic Information Portal which makes hazard data 

freely available. The data can be used in conjunction with 

FEMA’s free HAZUS software to plan for emergency re-

sponse to the event itself - and beyond, including debris re-

moval and making the area livable again.  

Jon Greninger and Suzy Brunzell from Snohomish County 

discussed how they created a GIS team that meets quarterly 

to tear down data silos and create GIS datasets that fit emer-

gency management business needs. Their goals are to pro-

vide useful maps and GIS applications for Emergency Opera-

tions Center staff, knowing that teams responding to an 

emergency have just minutes to produce maps of the mission 

area before deploying. One of the key points they stressed is 

that workstations and emergency data stores need to be on 

site before an emergency happens.  

Afterwards, the presentations transitioned to the details of 

integrating GIS data into the public safety environment, in-

cluding 9-1-1 dispatch. First responders work under unique 

Presentations by Mike Price (left photo) and Lt. Chris Rogers  (right photo). 

http://www.dnr.wa.gov/ResearchScience/Topics/GeosciencesData/Pages/geology_portal.aspx
http://www.dnr.wa.gov/ResearchScience/Topics/GeosciencesData/Pages/geology_portal.aspx


 

 

our GIS software to coincide with the upgrade of our mainte-

nance management system. The upgrade of our maintenance 

management system will require us to upgrade our ArcGIS 

software to the latest version (10.2).  This upgrade will also 

require that we convert a large portion of our data from Au-

toCAD to ArcGIS, as the system only uses GIS data. The cur-

rent version of the maintenance management system uses an 

outdated Esri MapObjects-based mapping system that only 

runs as a local desktop application; there is no web, tablet or 

smartphone component. After the system is upgraded, it will 

be able to use GIS across desktop, web, tablet and 

smartphone platforms. 

The assessment also showed that the City needs to complete 

the mapping of its stormwater system. As of last November 

the system was only about 60% mapped and no mapping 

work had been done on it for several years. The primary rea-

son the City needs to complete this mapping is to comply 

with our Department of Ecology stormwater permit require-

ments. To get this mapping completed, we are currently us-

ing our new GPS unit to map stormwater infrastructure in 

the field. We are also working closely with the stormwater 

field crew to get their feedback.  

(Continued from page 12) 
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Another GIS tool that the City recently started using is the 

Esri local government enterprise licensing agreement, com-

monly known as an “ELA”. This licensing gives the City al-

most unlimited access to their GIS software. We’ve already 

put this valuable tool to work by giving field crews access to 

GIS software that is helping to make their work easier and 

more efficient. Previous to having these tools, they used the 

outdated MapObjects-based GIS viewer which has no editing 

capability and limited cartographic options. 

In order to continue the legacy of building a regional GIS 

system, the City has entered into a geospatial data sharing 

agreement with Thurston County. The City has been a data 

sharing partner with the County since 2010. This year the 

City plans to update our agreement with the County to make 

it more permanent.  

It’s an exciting time to be here in Tumwater and have the 

opportunity to build the GIS system into the great tool we all 

know that it can be. There’s a lot of work ahead for us to 

grow and enhance the system but we’re off to a good start. 

Lastly, we’re looking forward to working and collaborating 

with our local partners and the rest of you out there. Thank 

you for reading and hopefully we’ll have another update on 

our progress before too long.  

The Story of Digital Mapping & GIS at the City of Tumwater 

conditions, and GIS professionals often aren’t aware of the 

best way to provide critical information in an easy-to-use 

format. One surprise to many of the GIS professionals was 

learning that maps are often viewed under red light, which is 

used to protect the responders’ night vision. Therefore, red 

symbols on the map can be difficult to see. 

Lt. Chris Rogers (Kirkland Fire Department) fights fires, 

knows cartography, and is very involved in public safety GIS. 

In his presentation, he urged GIS professionals to get to know 

firefighters – and public safety professionals to learn basic 

GIS. His message: the most important thing is to work togeth-

er:  making maps, using them and providing honest and re-

spectful feedback so maps can be improved.  It takes signifi-

cant effort to create useful maps with clear symbology for use 

under stressful conditions. It is crucial to develop a carto-

graphic standard so responders know what they are looking 

at, even if they pick up a brand new map.  

Other presentations were: 

“FEMA GIS Support During Disasters” – Joshua Keller, GIS 

Coordinator at FEMA Region X  

“Emergency Services data acquisition, development, and 

deployment in the Kent Regional Fire Authority” – Mike 

Price, Entrada/San Juan, Inc. and Scott Corwin, GIS Adminis-

trator at Valley Communications Center 

“Putting King County GIS to Work at the Regional Commu-

nications & Emergency Coordination Center” – Cheryl Wil-

der, Training Coordinator/GIS Data at King County GIS Cen-

ter 

Slides from the presentation are available online at: http://

www.waurisa.org/

Work-

shops/2014_Emergency_and_Disaster_Prep/2014_Workshop.

pdf 

http://www.waurisa.org/Workshops/2014_Emergency_and_Disaster_Prep/2014_Workshop.pdf
http://www.waurisa.org/Workshops/2014_Emergency_and_Disaster_Prep/2014_Workshop.pdf
http://www.waurisa.org/Workshops/2014_Emergency_and_Disaster_Prep/2014_Workshop.pdf
http://www.waurisa.org/Workshops/2014_Emergency_and_Disaster_Prep/2014_Workshop.pdf
http://www.waurisa.org/Workshops/2014_Emergency_and_Disaster_Prep/2014_Workshop.pdf
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with the selected structures. Registration is simple and re-

quires only an email address and self-selected username to 

facilitate on-going participation. Volunteers include youth 

from various organizations such as 4-H and scouting, as 

well as retirees, students, and even GIS experts in local, 

state, and federal agencies. Out of a total of about 5,500 total 

structure points in Washington, over 900 have been checked 

by volunteers (Figure 5), so there are still plenty of opportu-

nities to become involved.   

Through their participation, volunteers make significant 

contributions to the USGS's ability to provide the nation 

with accurate and freely available mapping information to 

support response planning for natural hazards and to pro-

vide critical data for sustaining and improving the quality of 

life and economic vitality. 

and participant motivation. The National Map Corps endeav-

ors to meet these challenges using gamification techniques 

and a mixture of traditional and social media. Gamification 

includes easy on-ramping, virtual recognition badges, friend-

ing, map challenges, social media interaction, and a tiered 

editing approach. Using these techniques has been successful. 

The National Map Corps continues to see substantial increases 

in the number of volunteers and volunteer contributions to 

The National Map.  

States were released in 3 phases beginning in April 2013 with 

all 50 states available for editing as of August 2013. Over the 

past year TNMCorps has achieved the following significant 

milestones: 

 1,422 volunteers 

 42,009 contributions (counts each person’s edit per single 

point) 

 33,698 unique points edited (individual structures) 

 50,696 total number of edits (the sum of all edits made by 

volunteers) 

 50 number of states involved 

 18 number of volunteers who have contributed more 

than 500 points 

To show appreciation of volunteers’ efforts, The National Map 

Corps instituted a recognition program that awards “virtual” 

badges to volunteers. The badges consist of a series of antique 

surveying instruments ranging from the Order of the Survey-

or’s Chain to the Theodolite Assemblage (Figure 4).   

Additionally, volunteers are publicly acclaimed (with permis-

sion) via Twitter, Facebook and Google+.  “I enjoy mapping 

structures, it’s a unique combination of validating structures 

from aerial photography and web-based sources,” says 

TNMCorps volunteer Don Kloker. “My structures contribu-

tions have provided me with an excellent geography lesson 

and I have learned many things about communities that I 

most likely would not have been otherwise able to experi-

ence.” Don has contributed more than 2,000 points and quick-

ly reached the highest recognition badge, the Theodolite As-

semblage. 

Volunteers only need access to a computer and the Internet to 

participate. The National Map Corps’ website explains how 

volunteers can edit any area, regardless of their familiarity 

(Continued from page 3) 

Volunteered Geographic Information Drives USGS National Map Corps 

Figure 4:  Recognition Badges  

Figure 5:  Washington State showing volunteer contributions in green 

and structure points available for editing in dark purple. 

http://navigator.er.usgs.gov/help/vgistructures_rewards.html
https://twitter.com/USGSTNM
https://www.facebook.com/USGeologicalSurvey?ref=br_tf
https://plus.google.com/u/0/112238984598711890000/about
http://navigator.er.usgs.gov/
http://navigator.er.usgs.gov/
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“Thought Leaders.” Does that phrase sound familiar? Well, 

we are shamelessly borrowing the idea from other confer-

ences where we’ve seen it work very well as a way for 

attendees to candidly share comments, ideas, and criticisms 

related to our geospatial community, and-in our case, cen-

tered around our conference theme Communicating Our 

World. These thought leaders will actively gather your feed-

back during track sessions and conference conversations, and 

at the closing session everyone will participate in a panel 

discussion to review the key themes that were revealed dur-

ing the conference.  

(Continued from page 1) 

Come prepared to share your ideas, and 

together we can make this conference 

and its impact on your professional 

work the very best it can be. 

President’s Column 

Furthermore, our department has grand visions of future 

GIS application and its integration with existing district 

data/systems. One exciting opportunity we see that will 

serve as a foundation for future work with GIS is integrating 

our extensive architectural and site CAD drawings into GIS 

to better manage our school buildings. The University of 

Washington has done some incredible work in regard to 

CAD/GIS integration, and our hope is to use some compo-

nents of their work as a model to facilitate this process. Once 

we have our interior space mapped within a GIS environ-

ment, our vision is to use a GIS-based application as a user-

friendly front end to interact and manage information and 

systems such as classroom utilization, integration with the 

district’s facilities work order system, and school security 

systems such as door entrance controls, mass announcer and 

network-enabled security camera systems.  

In order to accomplish these goals, additional resources will 

be required in terms of funding and staffing. Our school 

district recently submitted a school safety grant application 

administered by the Office of Superintendent of Public In-

struction (OSPI) that could potentially provide funding to 

begin this process and begin work on the CAD/GIS integra-

tion mentioned above. 

On a personal level, I’d like to see GIS taught in our school 

district, beginning at the high school level. I think AGO 

would be an incredible tool for some of our educators, par-

ticularly in the field of STEM (Science Technology Engineer-

ing Mathematics) education. Esri and OSPI’s Education 

Technology Department, led by Dennis Small, have part-

nered to provide Esri software and training for free to edu-

cators through an Educational Statewide license. In other 

words, it costs nothing for our teachers to use Desktop, 

AGO, and many online training options in the classroom. 

However, it is a resource that is highly underutilized. More 

information on the Washington State K-12 Education 

statewide license can be accessed at: https://www.k12.wa.us/

EdTech/EdSoftware/GIS.aspx 

It’s a personal aspiration that Puyallup School District will 

offer a GIS class that my twin kindergarten boys can take by 

the time they reach high school.  

(Continued from page 14) 

WAURISA GIS Conference Preview 

One payoff for contributing your ideas as part of this new 

process includes the chance to better know your colleagues – 

the many diverse and incredibly talented people who share 

space in our geospatial community. I had the pleasure of 

attending the GIS in Action conference in Portland this 

month, hosted by our neighbors to the south – Oregon URI-

SA, and I noticed a quote printed in their conference program 

that reminds me of the reason we’re incorporating thought 

leaders into our conference structure: “No one can be the best 

at everything. But when all of us combine our talents, we can 

be the best at virtually anything.” (Don Ward).  Come pre-

pared to share your ideas, and together we can make this 

conference and its impact on your professional work the very 

best it can be, and along the way, enjoy the opportunity to 

better know and understand our colleagues.  We hope the 

synthesis of this work will also serve as a spring board for 

new professional development workshops, networking and 

mentoring opportunities, and increased relevance in all activ-

ities WAURISA offers its members and the Washington geo-

spatial community. You can learn more about the Thought 

Leaders role, and other new conference features on page 8 of 

this issue and on our conference website. 

That’s it for now. Please enjoy this issue of The Summit, and 

I’ll see you in a couple of weeks. I’m looking forward to 

spending time at the conference with you!  

https://www.k12.wa.us/EdTech/EdSoftware/GIS.aspx
https://www.k12.wa.us/EdTech/EdSoftware/GIS.aspx
http://www.waurisa.org/conferences/2014_Conference_Index.php


 

 

Editorial 
By: Eadie Kaltenbacher, GISP 

O 
ne of my first experiences in GIS, a decade ago, 

was working with a mineral resources consulting 

company. In addition to creating features specific 

to our projects (sample sites, geological data), I also had to 

create base data to represent features such as roads and wa-

terbodies. Today, these features are generally accessible from 

authoritative sources such as state or local government. Hav-

ing a central repository can save on valuable resources since 

end users don’t have to reinvent the wheel, plus the data can 

be more accurate and comprehensive.  

It was fascinating for me to assemble this issue of The Summit 

because of the different perspectives on such a central reposi-

tory.  The City of Tumwater participates in a regional GIS, the 

State DOT integrates road data from local agencies (p. 8), 

while the USGS collects structure data from citizen volunteers 

(p. 2). The story of ArcGIS Mobile explains how we can get 

field-collected data into our systems (p. 5), and URISA’s GIS 

Management Institute published a paper advocating for a 

national data sharing infrastructure (p. 13). Bringing it all 

home are the stories of the Emergency Management Work-

shop (p. 15 & 16) where, sadly, the multi-department GIS 

team of Snohomish County working on centralizing data for 

emergency management was tasked with the tragic Oso mud-

slide last month. 

GIS is a relatively young field, but we are entering the maturi-

ty stage where we can begin to address some of our major 

challenges. Who are the best resources to create local data? 

How do we ensure that data is high-quality? How do we keep 

it current? How do we share it nationally, or even internation-

ally, and further make it accessible in the event of a disaster? 

These questions and more keep me engaged in GIS. What 

about you? Bring your thoughts and ideas to share at 

WAURISA’s annual GIS conference next month (p. 7) and 

“Communicate Our World”. 
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Public Maps in Washington 

“T 
he traveller from the coast, who, after plodding 

northward for a score of miles over calcareous 

downs and corn-lands, suddenly reaches the 

verge of one of these escarpments, is surprised and delighted 

to behold, extended like a map beneath him, a country differ-

ing absolutely from that which he has passed through.” 

 

-from Tess of the D’urbervilles, by Thomas Hardy 

The Summit is the newsletter of WAURISA. To encourage the 

discussion of issues and ideas of importance to the Washing-

ton GIS community, we welcome letters to the editor or opin-

ion essays. Letters should be a maximum of 100 words and 

essays should be limited to 500 words. 

Chief Editor: Eadie Kaltenbacher 

Editorial Board: Eadie Kaltenbacher, Greg Babinski, Effie 

Moody 

Interview Editor: Michelle Lortz 

Proofing: Karl Johansen 

For subscriptions, content, comments, or suggestions, email:  

Summit@WAURISA.org 

Submit articles to The Summit for publication by: 

Summer Issue: July 11, 2014 

Autumn Issue: October 17, 2014 

UPCOMING DEADLINES 

Attending the WAURISA GIS Conference in May? If you take Taco-

ma Link light rail, you will see this map at the station. 

Literary Corner 

mailto:Summit@WAURISA.org
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WAURISA thanks the following sponsors for their generous support: 

 
Esri’s geographic information system (GIS) software gives you the power to think 

and plan geographically. GIS is used in more than 350,000 organizations world-
wide. It helps cities, governments, universities, and Fortune 500 companies save 
money, lives, and our environment. Whether transporting ethanol or studying 

landslides, these organizations use GIS to collect, manage, and analyze geographic 
information, which helps them see relationships, patterns, and trends. They can 
then solve problems and make better decisions because they are looking at their 

data in a way that is quickly understood and easily shared.  

 The King County GIS Center provides quality service and exceptional value for 
our clients with one of the most capable GIS organizations in the Pacific North-
west. Unlike most consultants, our professional staff members are not merely 

theoreticians, but practicing users of the types of GIS solutions government and 
business require. Why do we offer our services to outside customers? We have 
a long-term interest in the success of GIS throughout the region. We know that 

our success depends on satisfied clients and we are committed to delivering 
quality GIS business solutions that provide value for our customers. Let KCGIS 
help you put GIS to work!  

 

Electronic Data Solutions proudly offers sales and support services for Trimble 
GPS mapping systems, Esri GIS software, Laser Technology rangefinders, Ricoh 
GPS Digital Cameras, Juniper Systems field computers, In-Situ water level and 

water quality instrumentation and Teledyne RD Instruments Acoustic Doppler 
current profilers. We provide industry specific software and expert guidance 
while assisting you to find exactly what you need to efficiently capture field data.  

 

Intergraph is the leading global provider of engineering and geospatial software 

that enables customers to visualize complex data. Businesses and governments in 
more than 60 countries rely on Intergraph’s industry-specific software to organ-
ize vast amounts of data to make processes and infrastructure better, safer and 

smarter. 

 

DEA is a multi-discipline engineering firm employing over 600 professionals serv-
ing the Transportation, Energy, Land Development, Water Infrastructure, Sur-

veying and Geomatics, and Marine Services markets. Offices located in Oregon, 
Arizona, California, Colorado, Idaho, New York, and Washington.  

 

GeoLine provides positioning solutions that will increase our customer's produc-
tivity and profitability by integrating a wide range of positioning technologies into 
a complete solution.  

 Since 1999, Latitude Geographics has helped people succeed with web-based 
geography by enabling them to make better decisions about the world around 
them. Hundreds of organizations worldwide rely on Latitude Geographics’ Geo-

cortex software to accelerate and enrich the process of designing, building and 
maintaining world-class Esri ArcGIS Server and ArcGIS Online applications. Esri 
is the world’s leading GIS platform, and in 2010 Latitude Geographics was recog-

nized as an Esri Worldwide Partner of the Year and one of the first to be named 
as an Esri Platinum Partner. For more information about our products and ser-
vices, please visit www.geocortex.com  

www.esri.com 

www.kingcounty.gov/gis 

www.elecdata.com 

www.intergraph.com 

www.deainc.com 

www.geoline.com 

http://www.geocortex.com
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Terra GIS provides expertise in Geographical Information Systems, consulting for 

social and environmental issues, and subjects related to sustainable development. 
Services include environmental research, field work and reporting, spatial analy-
sis, cartography, implementation of web mapping and information systems, and 

the creation of specialized tools related to conservation, natural resources man-
agement, and public and social engagement issues.  

 

Since 1927, the PPI Group has been the go-to solution for our clients in the A/E/
C industries. With more than 80 years of hands-on experience, we're an un-

matched resource for industry knowledge. The PPI Group is one of the largest 
survey and construction supply companies on the West Coast and an authorized 
dealer of Topcon equipment and Autodesk software solutions.  

 

CycloMedia's GIS accurate street-level imagery is used in asset management and 
mapping, property appraisal, and infrastructure planning. Our precision panoram-

ic photos can be delivered as a cloud-based service or on client hosted servers 
and accessed via full-featured web applications or inside leading desktop GIS 
software.  

 

CRW Systems, Inc. is a professional engineering and consulting firm headquar-

tered in San Diego, CA. We provide dynamic solutions to Community Develop-
ment, Code Enforcement, Public Works, Planning, Fire, and Building Depart-
ments. TRAKiT’s GIS-centric automation utilizes ArcGIS Server 10 to help cus-

tomers configure workflows and eliminate the duplication of work providing 
greater efficiencies in the processing of plans, permits, licenses, and violations.  

 
Since 1996, Cityworks® has been streamlining the way agencies manage public 
infrastructure and property by combining the asset geodatabase with the business 

logic of agencies that care for infrastructure and property. An authoritative re-
source and system of record, Cityworks elevates Esri®’s ArcGIS® Location 
Platform specifically to manage workflow, schedule resources and prioritize 

activities—saving time and improving operational efficiencies. Time-tested and 
proven technology, Cityworks is Empowering GIS® at more than 500 organiza-
tions around the world. 

 

Marshall GIS is a leading provider 
of GeoKNX® middleware soft-

ware products to facilitate and 
simplify the integration of Esri's 

ArcGIS with other Enterprise 

Asset Management (EAM) com-
plex business systems such as 
Infor Hansen, IBM Maximo and 
Lucity. Enterprise application 

integration and mobile technolo-
gies are the two key areas where 
we can support your organization 

with years of experience and 
software solutions.  

 

Sidwell has provided comprehen-

sive mapping and land record 
information systems to local gov-
ernment for over 80 years. Sidwell 

is a national industry leader of GIS 

solutions for cadastral mapping 
and land-records management, 

and a provider of aerial photog-
raphy, software development, and 
photogrammetric services. Sidwell 
provides outstanding solutions to 

our clients to enable them to 
achieve their goals now and in the 
future. Sidwell is an Esri Gold Tier 

Partner.  

www.terragis.net 

www.theppigroup.com 

www.cyclomedia.com 

www.crw.com 

www.cityworks.com 

www.marshallgis.com www.sidwellco.com 
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GIS User Groups in Washington 
 

ACSM – Washington State Section 

www.wss-acsm.org 

 

Cascadia Users of Geospatial Open Source 

groups.google.com/group/cugos  

Contact Karsten Venneman 

 

Central Puget Sound GIS User Group 

Join Listserve here  

 

Central Washington GIS User Group 

Meets the 2nd Wednesday of each month. 

Contact Amanda Taub 

 

Cowlitz-Wahkiakum GIS User Group 

Meets the last Wednesday of each month at 3:00 pm at the 

Cowlitz-Wahkiakum Council of Governments meeting room, 

207 North 4th Ave, Kelso WA. 

Contact TJ Keiran 

 

King County GIS User Group 

www.kingcounty.gov/operations/GIS/UserGroups.aspx 

Meets 1st Wednesday every other month at 11:00am at the 

KCGIS Center, 201 S. Jackson Street, Seattle WA, Conf Room 

7044/7045. 

 

Northwest Washington GIS User Group 

www.wwu.edu/huxley/spatial/nwwgis/nwwgis_mtgs.htm  

 

Southeast Washington/Northwest Oregon GIS User Group  

web03.pocketinet.com/~sewa-neor-gis/sewa-neor-gis.org/

index.html  

 

Washington Geographic Information Council (WAGIC) 

geography.wa.gov/wagic  

Join Listserve here  

 

Washington Hazus Users Group 

http://www.usehazus.com/wahug  

Contact Kelly Stone 

WAURISA 

1402 Auburn Way North 

PBN 158 

Auburn WA 98002 

WAURISA Contacts 
 

Board of Directors 2013-2014 

Heather Glock  President  

Ian Von Essen  Vice President 

Sarah Myers  Secretary  

Don Burdick  Treasurer  

Ann Stark   Past President  

 

Board Members At-Large 

Cort Daniel 

Joshua Greenberg 

David Howes 

Suzanne Shull  

Josh Sisco  

Dana Trethewy 

 

WAURISA Committee Leads 

Chuck Buzzard  Conference Lead   

Joshua Greenberg  Education   

Don Burdick  Finance   

Amanda Taub  Marketing   

Suzanne Shull   Membership  

Don Burdick  Nominating   

Cort Daniel  Technology   

 

The Summit  

Eadie Kaltenbacher Editor-in-Chief   

To have your GIS-related group or event listed in future issues 

of The Summit, notify the editor at: Summit@waurisa.org  

 

To be added to The Summit mailing list, contact:  

Marketing@WAURISA.org 

Back issues of The Summit are available at:  

http://waurisa.org/thesummit/ 

Interested in volunteering your time to help WAURISA? Con-

tact any Board member listed on the right. 
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